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Abstract


Stuart Fehr and Matt Gimlim created an Eclipse plug-in to contain Java tutorials that Software Engineering students can use during their lab sessions. They created a plug-in for Eclipse version 3.2 that uses the inner web browser of the Eclipse window to link to a remotely hosted website containing tutorials. However, some features that are beneficial to students were not implemented. Also, Eclipse.org has released a new version of the Eclipse IDE. Features required for the plug-in include:

· An installation package

· A set of tutorials indexed by topic

· Ability to search for tutorials

· Ability to add new tutorials


In addition, the old version of the plug-in must be adapted to be used by the newest version of Eclipse, tutorials must be made and archived, and a subversion repository must be made to house the example programs used in the tutorials.

Introduction


Several semesters ago, Matt Gimlim and Stuart Fehr conducted a study of student behavior while the students were completing their lab assignments for the Software Engineering course at the Colorado School of Mines.  Their findings showed that a high level of distraction resulted when the students transitioned between their computer screens and textbooks. The suggestion given by Gimlim and Fehr was to create a plug-in for the Eclipse development environment that would contain tutorials for the Software Engineering program at the Colorado School of Mines.
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Figure 1. The benefit our plug-in will give to students.


The Eclipse Plug-in Creation Process

Eclipse is an application that allows for third party add-ons for increased functionality via plug-ins. The Eclipse IDE offers users a wealth of tools to assist in the plug-in development process through plug-in templates and online tutorials.


During the creation of any Eclipse plug-in, there are seven key steps to follow: 

· Create the plug-in project 

· Edit the manifest and write the Java code 

· Test and debug the program 

· Externalize the strings 

· Clean-up the manifest 

· Configure the build content 

· Export the plug-in 

Proper execution of these steps will allow any user to create useful plug-ins that contribute to the Eclipse community. 

Create the plug-in project 

To create a new plug-in project, go to File->New->Other… and select Plug-in Project within the wizard. Give the plug-in a name and click Next. On the next page, the user will most likely want to leave everything as it is. Click Next, and the next page will ask if the user wants to start the project using one of the built-in templates. If a template is selected, click Next to configure the template, otherwise click Finish. 

Edit the manifest and write the Java code 

Within the manifest editor, the user will need to specify the list of dependencies or in other words, the list of other plug-ins that the plug-in requires to function within the Dependencies tab. The code for the plug-in will then need to be written and placed in a package. This code will be the driving force behind the plug-in and will ultimately determine its behavior and functionality. The user will need to select this package for exportation within the Runtime tab of the manifest editor. The last thing to do is to define the extensions for the plug-in within the Extensions tab. These extensions determine the appearance of the plug-in within Eclipse such as creating a “view”, a “toolbar menu”, or a “toolbar button”. 

Test and debug the program 

This step is simple and straightforward. Go to Run->Run As->Eclipse Application. The Eclipse editor will launch another instance of the Eclipse IDE that implements the plug-in. The functionality of the plug-in can then be tested and changes can be made accordingly. 

Externalize the strings 

Externalizing the strings is only necessary if the user wants to adapt his plug-in for use with other languages. The process of externalizing strings is called internationalization. The user can externalize the strings via a wizard within Eclipse. To do this, go to the Overview tab and right click anywhere within the window. Click Externalize Strings…, select the plug-in, and click Finish. The wizard will then externalize all necessary strings. 

Clean-up the manifest 

After the user is satisfied with the performance of the plug-in, he may need to clean-up the manifest to remove any unnecessary dependencies, imported/exported packages, extensions, etc. This ensures that only the required files and libraries are included and minimizes the size of the plug-in. 

Configure the build content 

Once everything is working properly, the build content needs to be configure properly prior to exportation. Usually, this includes specifying the library that the compiler needs to build from the source code that the plug-in will utilize during execution. Other files will need to be selected for the binary build such as images, and the plugin.xml. 

Export the plug-in 

The plug-in is now ready to be exported as a installable plug-in to the Eclipse framework. Go to File->Export… and select Deployable plug-ins and fragments. Select the plug-in, specify the directory to export to, and click Finish. The wizard will export the plug-in in a .jar format and can be installed in the `plugin' folder within the Eclipse directory. 

Requirements


Requirements for the plug-in are split up into functional and non-functional requirements and will be discussed below.


The functional requirements of this project include:

· Display tutorials within the Eclipse IDE

· Index tutorials by subject

· Search for tutorials by subject/ key word

· Reference Subversion

· Installable

 
The non-functional requirements of this project include:

· Create Tutorials

· Tutorials adapted to the subject desired


Functional Requirements


The goal of this project was to create a plug-in for the Eclipse IDE to be used by the students of the Software Engineering course at the Colorado School of Mines.  This plug-in needed to display examples relevant to the students' homework assignments, along with brief explanations of those examples.


The basic requirement was for the tutorial window to show up in the same window as the Development Environment. This will provide a reprieve from the distraction of moving from textbook to screen and back again or from changing windows in order to get information useful to the lab session. From this requirement stems other requirements that allow the user to easily navigate through the content of tutorials provided.


The next requirement involves indexing all of the material for the tutorial files. The way that the material is indexed is key to accessing the material quickly. The use of an index easily and effectively decreases the amount of time spent searching for items of interest.  This is required for our plug-in because the focus is to decrease the amount of distraction and time spent during lab sessions for the students.  


Another requirement of our final product was to implement a search function for all of the material in the tutorial files.  The search criteria will be the subject and a few keywords, and the results will be the tutorial files that contain the specified search criteria.


During this year, a new technology was introduced to the students in Software Engineering called Subversion.  Subversion is a piece of software that supports the version control aspect of Software Engineering.  This technology is very important since during the development of any piece of software, there exist multiple versions that are introduced and are then expanded or enhanced.  Our plug-in requires that the example programs that we create are hosted on Subversion and accessible to the students. This also requires that a tutorial about using Subversion be included within the final product.  We are responsible for setting up the content on subversion and letting the students know through the tutorials how to access and maintain it.


For the project to be declared fully functional, there is a condition that the plug-in needs to be installable on any computer, and to be usable on any computer.  This requires that we adapt the plug-in so that it is installable, and to adapt the web page to be usable by any web browser.  Also, the plug-in must be visually acceptable and professional in all aspects.

  
Non-Functional Requirements:


Initially there were no tutorials made for this plug-in, and thus another criterion for our project was to create simple tutorials for Colorado School of Mines students to follow during their lab sessions.  These tutorials will be indexed for the plug-in and will be made searchable.


The subject matter contained within the tutorials was decided upon by both our client and ourselves.  The contents of the tutorial file include basic syntax information regarding the subject, as well as references to sample programs that introduce the student to implementations of the material he is reviewing.  


New resources for the Eclipse Development Environment are released to the public on a regular basis.  There are tools for Eclipse that allow the user to edit and implement more than just Java code.  There exist plug-ins that allow the user to edit and implement C, PHP, HTML, CSS, and many other programming languages from within the Eclipse IDE.  Certain of these resources have become appealing to the Math and Computer Science department at The Colorado School of Mines. Thus we have also been charged with creating tutorials that teach the student how to update his Eclipse Environment in order to use certain plug-ins that have become appealing to the MACS department. These plug-ins include UML2 and VE, the UML and Visual Editor tools for Eclipse.


Our plug-in is designed to make learning Java easier.  Many students live off-campus, and do their assignments off-campus.  It is therefore necessary that those students be able to access these tutorials from computers outside the Colorado School of Mines network.

Design and Solution 


A base existed for this project's plug-in, which Matt Gimlim and Stuart Fehr created. Their plug-in simply used a 'Tutorial Navigator' window, which appeared next to the 'Console' window, to display HTML webpages within the Eclipse IDE. This allowed the tutorials, written as HTML pages, to be displayed in the same window that the students use to write the code for their assignments. Their plug-in included ‘Forward’ and ‘Back’ navigation buttons. Our design includes an expansion of these buttons to include ‘Refresh’, ‘Stop’, and ‘Home’. 


Since the plug-in displayed HTML files, it makes sense to write the tutorial for each subject as a separate HTML file. These HTML files must then be indexed in an intuitive way so that students can find the subjects they are looking for. The homepage of the plug-in lists the tutorial categories such as Graphical User Interfaces (or GUIs), and Basic Concepts on the left hand side with a tutorial viewing window on the right hand side.

 
However, a student may know exactly what he needs help on, but not know what category it would be under. Therefore, a search function was necessary. We implemented the search field with PHP, using a MySQL database, and integrated it with the rest of the main page shown within the plug-in's tutorial window. Suppose one of the assignments tells the student to create a GUI but leaves the student to design what the GUI will do. John Q. Hacker may not know what he would like to use, and can browse the tutorials by subject to get a better idea of what to do.  Jane S. Tool-tip, on the other hand, knows exactly what she wants to do but is not sure which subject to look under.  She can use the search function.  


The MySQL database for the search function contains three tables: keywords, tutorials, and tut_key (See Figure 2.).  Each table includes a ID number for cross-referencing.  The tut_key table is the table that is actually searched.  The tutorials table contains links to the HTML page for each tutorial.  The tutorials table also contains a brief description of each tutorial, to clarify what the tutorial covers.  After a student types something into the search field on the homepage of the plug-in, the PHP code will display the keywords, link, and description of each tutorial that matched the search.  The student can then use the link to view any of the tutorials.
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Figure 2.  Picture of the tables and their links to each other.

The tutorials are HTML files that refer to specific pieces of example code, which are also available on Simon through Subversion.  The example code comes from many sources including code written by the client as well as code adapted from textbook examples.


Since this plug-in is a Colorado School of Mines project, it is imperative that the school's technology is incorporated into the application. In the case of this plug-in, the school's web server is used as a host for the web page that is displayed in the Tutorial Navigation Window.  This process involves communicating with the school's administration as well.  Along with this, we created a tutorial for setting up a VPN to the Mines Network, so that students can access this web page from their homes off campus.

Implementation


The Plug-in

Making the plug-in for our field session project was relatively easy due to the fact that a precursor had already been made by Gimlim and Fehr. However, the plug-in made by these two students was not compatible with Eclipse 3.3 nor was it configured to export properly for installation into Eclipse. What our team needed to do was to create a new plug-in project and add the existing code from the previous plug-in. The critical piece, as simply as it sounds, was selecting a checkbox in the plug-in project wizard that allowed the plug-in to make changes to the Eclipse User Interface. Once the new project was created and the code added, the plug-in ran as it was supposed to. However, it lacked a good Graphical User Interface, as well as some needed functionality. The plug-in, by default, created a 'Tutorial Navigator' view within Eclipse, appearing right next to the 'Console' view (see Figure 3), that opened up a web browser set to a default homepage. Only a 'Forward' and a 'Backward' buttons were available within the browser and were labeled with plain text. 
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Figure 3. A screenshot of the plug-in showing the 'Tutorial Navigator' view.

The first task for revamping the plug-in was to add more buttons, 'Refresh', 'Stop', and 'Home', and was accomplished with minimal effort within the code. The hard part was setting the buttons to display an image on them. Java has a default Image object type that is defined in the java.awt.Image library. However, in order to set up the web browser, the code for the plug-in utilized the org.eclipse.swt library, that has its own definition for the Image object type. When setting the buttons to have an image on them, the compiler was unable to resolve the conflicting Image object types. This error took a considerable amount of time to assess its cause, but once the cause was determined, the images were added without further hassle. In addition to the button images, an icon depicting The Colorado School of Mines 'M' logo was added to the 'Tutorial Navigator' view. All of the images were saved in .gif file format so that we could take advantage of the transparency property that .gif files support, allowing us to remove the white background on each image.

Handling the utilization of these images was a bit tricky.  In standard Java projects, extra resources such as text files and images are saved in the project folder and can be accessed within the code without the need to specify their exact directory. By default, the Eclipse IDE looks for these resources in the project folder, since it is within this folder that the code is being executed. However, the same is not true for plug-in development. Since the plug-in's code is extending the capabilities of the IDE, the IDE itself is executing the code. Therefore, the default folder that the compiler looks in for extra resources is the Eclipse folder. As a result, we had to code the plug-in to look for the images within the Eclipse folder in the location that the images would be saved to after installation. Therefore testing the plug-in became rather tedious, since each revision had to be installed in order to fully test it.

The plug-in was then configured within the 'Manifest Editor' to export properly. This included selecting certain build options as well as specifying the library to be exported that the plug-in would utilize upon startup in Eclipse. 

The Java Tutorial Files

In order to display the tutorial files, the plug-in uses Eclipse’s internal web browser.  PHP files are then used to display the material of the tutorials.  Linking the internal web browser to the main page of the tutorial menu is as simple as setting the URL within the Java code used to make the plug-in.  The implementation of the PHP site was more difficult.

In order to display an index of the tutorials, our team used a simple unordered list scheme and displayed it within an IFRAME on the left hand of the main page. Each link within the unordered list is targeted at the right IFRAME which initially contains a welcome message and a small written explanation about how to use the site and the index.  An IFRAME is a framing scheme used by current HTML programmers to divide the display of an HTML or PHP file. The search function is included at the top of the left IFRAME above the index. This same functionality could have also been achieved using the older FRAME scheme. However, the FRAME scheme is deprecated, causing IFRAME to be the scheme of choice.

Designing and implementing the search function was a difficult and new experience for the team. It involved the cooperation of MySQL and PHP, with HTML embedded within.  MySQL is a databasing piece of software developed by Sun Microsystems and is used by a multitude of software and products. A diagram of our MySQL database is included below.  PHP cooperates with MySQL by using PHP functions that connect to the database and manage database functions.  Every time a new tutorial is introduced, the MySQL database must be updated with new keywords and subjects.

Figure 4. Our MySQL database listing all of the Java tutorials.

When using our search function, a student will input his search criteria into a text field. The textual input is then retrieved via the FORM tag in HTML. PHP then uses the entry to query the database for matching cases, and then displays the matches for the query within the right hand side of the screen. PHP allows us to communicate efficiently between the HTML devised user interface and the MySQL database.

The security risk of SQL injection exists within our search function.  Users may be able to inject SQL code into our search field and vandalize the database.  We have implemented safeguards against this event by stripping the quotes and various punctuation from the search criteria when the search is submitted. This way, we avoid security risks including the deletion and/or insertion of data.

Results


After six weeks of work, we are pleased to report that we have created a working plug-in that successfully accesses our tutorial files. This plug-in is ready to be installed and utilized on campus computers at The Colorado School of Mines for the Software Engineering course at said school. In addition, we have uploaded all of our HTML files onto a database on the school server, Simon, and have made these resources available for use and updating by the professor.

Future Direction


Within the realm of the Software Engineering course, the tutorial database could be expounded upon to include more tutorials covering additional topics such as more advanced data structures and other useful plug-ins. Our Java Tutorial plug-in could also be adapted to work with other compilers to provide tutorials for additional courses besides Software Engineering.  We could also write a stand-alone plug-ins for those students that do not have internet in their households.  
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Abstract


In this paper, a new way to present tutorial material to a student is examined that removes

unnecessary excise, increases student’s attention at the concepts and materials, and provides immediate feedback to the user. By utilizing a plugin to the Eclipse development environment, all study materials and tutorial information can be integrated with the development environment in one window. This prevents the usual break in flow experienced by most students learning a new programming language with a standard tutorial.

1 Introduction


One of the major problems facing students in Computer Science programs and professional software developers is the challenge of adapting to and learning new programming languages and APIs. There are many tutorials for most programming languages and techniques available online. However, the non-interactive nature of these programming tutorials makes the material difficult for most students to absorb. In addition, many of these tutorials are written for a very very general

audience in an attempt to make them as accessible as possible. For many reasons, this can be a frustration to students and professionals that are already well versed in another programming language or computer science principles.


Our project was the development of a new type of tutorial system that was specifically geared toward students that were already well versed in another programming language. In our case, we assumed that our students would be well versed in C++ and would be learning Java, although the design principles presented in this paper could be applied to many other programming language combinations. Our specific goal was to develop a new type of tutorial that would address many

of the problems that we discovered with conventional static web-based programming language tutorials.1

2 RelatedWork


There are many fine examples of tutorials available free of charge online to learn the Java language. One of these is the tutorial provided directly by Sun Microsystems [1], the distributors of Java. This tutorial is geared well toward a very wide audience of people that may want to learn the Java language. There are almost no gaps in the material that is covered by this tutorial, and it is available on their website, making it accessible from anywhere. In addition to good discussion of programming technique in Java and extensive example code to illustrate their concepts, the Java tutorial also includes informative graphics where appropriate and sometimes small Java applets to

showcase some of the interesting things that can be done with Java programs. 


There are also a myriad of books available on the Java language, too many in fact to discuss them in any depth. However, we found a book approach to be even more difficult to use than a web-based approach. The reason for this is that the flow of the students learning and programming process is repeatly broken by having to adjust between using a computer and navigating and using a reference book. In addition to the problem of having to constantly switch between the book and computer, unless the book came with a CD of source code there is no way for the student to compile and test that code directly, other than to tediously type in all of that code by hand. This is a very boring process which incurs no real learning for the student. 


There have even been a couple attempts at making computer programming more accessible to students that would not normally learn a programming language. The most notable of these [2], used the idea of writing a novel to motivate the process of writing a computer program. However cute this may be, for a seasoned professional or an advanced student, this technique would be more annoying than useful for learning the Java language.

3 Design Philosophy


The main goals of our design were simple. First and foremost, we endeavored to never break the user’s flow. This was the primary reason that we chose to create a plugin to the Eclipse environment. We felt that allowing the user to do all of their reading and experimenting without having to switch contexts was very important. It was also important that the user get instant feedback when they made a syntax error. Instant error highlighting was one of the compelling reasons to use

Eclipse over any other text editing program that simply had syntax sensitive coloring.


In addition to never breaking the user’s flow, we chose to make this program read simple HTML pages so that it could be generic and not require significant reprogramming if someone wanted to apply this plugin to a different kind of programming language such as C++. The Eclipse environment has recently been expanded to offer C++ development capabilities which could also benefit from a built in tutorial. This also helped to make our tutorial environment similar to the

webbrowser environments that most users would already be comfortable in.


After observing students learning C++ in an introductory course at the Colorado School of Mines, we noticed that most people undertook a three step cycle when learning the C++ programming language. Each of these steps required switching contexts from one window to another, greatly breaking the user’s flow and forcing them to concentrate on navigational tasks rather than  the important concepts at hand. The first step was to read the programming assignment instructions from a webbrowser screen. The second was to do some programming and compile their results. This often required resolving syntax errors. If the student was confused about what to do, they changed to yet another window (this time a webbrowser as well) and read the online course notes. All of this navigational excise could be removed if the tutorial and assignment information was already contained in the same window which they user was programming in.

4 Results and Conclusions


Although we were unable to test our design implementation due to significant time constraints, we were able to draw some conclusions from previous research that we had done through interviews and observations of students actually learning C++. For most students, reading the text was not nearly as helpful as actually doing some coding to solidify concepts like syntax and object manipulation. Also, most students liked receiving immediate feedback about mistakes that they had made rather than having to read through compiler errors and guess at what they had done wrong. Our solution addresses both of these issues by encouraging the users to experiment with real code right inside the Eclipse environment and by utilizing the realtime syntax checking of the Eclipse environment to give the user instant feedback when they have made a mistake.


In addition to encouraging experimentation with real code, our solution also eliminates much of the excise found in the current workflow by putting all of the necessary elements in one window. This allows a user to concentrate more intensely on the material and concepts when their flow is never broken by unnecessary window switching. This also a major improvement over using a book, which poses an even greater amount of excise than switching between webbrowser windows.


We believe that this is a good first step in integrating the process of learning a new programming language with an advanced integrated development environment. The easy extensibility of Eclipse through plugins allowed us to experiment with a new pattern in learning programming language concepts that may prove to be a great step forward. We hope that this plugin may be used in a real student learning situation in the future. At such time, we may be able to judge the actual effectiveness of integrating learning materials with an integrated development environment.
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